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Important
The following functions are for reference only. Some series products may not support all the functions
listed below.

Cybersecurity Recommendations

1. Change Passwords and Use Strong Passwords

The number one reason systems get “hacked” is due to having weak or default passwords. It is
recommended to change default passwords immediately and choose a strong password whenever
possible. A strong password should be made up of at least 8 characters and a combination of special
characters, numbers, and upper and lower case letters.

2. Update Firmware
As is standard procedure in the tech-industry, we recommend keeping NVR, DVR, and IP camera
firmware up-to-date to ensure the system is current with the latest security patches and fixes.

“Nice to have” recommendations to improve your network security

1. Change Passwords Regularly
Regularly change the credentials to your devices to help ensure that only authorized users are able to
access the system.

2. Change Default HTTP and TCP Ports:

e Change default HTTP and TCP ports for systems. These are the two ports used to communicate and
to view video feeds remotely.

e These ports can be changed to any set of numbers between 1025-65535. Avoiding the default ports
reduces the risk of outsiders being able to guess which ports you are using.

3. Enable HTTPS/SSL:
Set up an SSL Certificate to enable HTTPS. This will encrypt all communication between your devices
and recorder.

4. Enable IP Filter:
Enabling your IP filter will prevent everyone, except those with specified IP addresses, from accessing

the system.

5. Change ONVIF Password:



On older IP Camera firmware, the ONVIF password does not change when you change the system’s
credentials. You will need to either update the camera’s firmware to the latest revision or manually
change the ONVIF password.

6. Forward Only Ports You Need:

e Only forward the HTTP and TCP ports that you need to use. Do not forward a huge range of numbers
to the device. Do not DMZ the device's IP address.

e You do not need to forward any ports for individual cameras if they are all connected to a recorder on
site; just the NVR is needed.

7. Disable Auto-Login on SmartPSS:

Those using SmartPSS to view their system and on a computer that is used by multiple people should
disable auto-login. This adds a layer of security to prevent users without the appropriate credentials
from accessing the system.

8. Use a Different Username and Password for SmartPSS:

In the event that your social media, bank, email, etc. account is compromised, you would not want
someone collecting those passwords and trying them out on your video surveillance system. Using a
different username and password for your security system will make it more difficult for someone to
guess their way into your system.

9. Limit Features of Guest Accounts:
If your system is set up for multiple users, ensure that each user only has rights to features and
functions they need to use to perform their job.

10. UPnP:

e UPnP will automatically try to forward ports in your router or modem. Normally this would be a good
thing. However, if your system automatically forwards the ports and you leave the credentials defaulted,
you may end up with unwanted visitors.

o If you manually forwarded the HTTP and TCP ports in your router/modem, this feature should be
turned off regardless. Disabling UPnP is recommended when the function is not used in real
applications.

11. SNMP:
Disable SNMP if you are not using it. If you are using SNMP, you should do so only temporarily, for
tracing and testing purposes only.
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12. Multicast:
Multicast is used to share video streams between two recorders. Currently there are no known issues
involving Multicast, but if you are not using this feature, deactivation can enhance your network security.

13. Check the Log:

If you suspect that someone has gained unauthorized access to your system, you can check the system
log. The system log will show you which IP addresses were used to login to your system and what was
accessed.

14. Physically Lock Down the Device:
Ideally, you want to prevent any unauthorized physical access to your system. The best way to achieve
this is to install the recorder in a lockbox, locking server rack, or in a room that is behind a lock and key.

15. Connect IP Cameras to the PoE Ports on the Back of an NVR:
Cameras connected to the PoE ports on the back of an NVR are isolated from the outside world and
cannot be accessed directly.

16. Isolate NVR and IP Camera Network

The network your NVR and IP camera resides on should not be the same network as your public
computer network. This will prevent any visitors or unwanted guests from getting access to the same
network the security system needs in order to function properly.

Electrical safety

® All installation and operation should conform to your local electrical safety codes.

® The power source shall conform to the requirement of the Safety Extra Low Voltage (SELV)
standard, and supply power with voltage rated by DC 12 V or AC 24 V according to the Limited
power Source requirement of IEC60950-1. Please note that the power supply requirement is
subject to the device label.

® Make sure the power supply is correct before operating the device.

A readily accessible disconnect device shall be incorporated in the building installation wiring

® Prevent the power cable from being trampled or pressed, especially the plug, power socket and the
junction extruded from the device.

® We assume no liability or responsibility for all the fires or electrical shock caused by improper
handling or installation.

Environment
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Do not aim the device at strong light to focus, such as lamp light and sun light, otherwise it might
cause over brightness or light marks, which are not the device malfunction, and affect the longevity
of Charge Coupled Device (CCD) or Complementary Metal-Oxide Semiconductor (CMOS).

Do not place the device in a damp or dusty environment, extremely hot or cold temperatures, or the
locations with strong electromagnetic radiation or unstable lighting.

Keep the camera away from water or other liquid to avoid damages to the internal components.
Keep the indoor device away from rain or damp to avoid fire or lightning.

Keep sound ventilation to avoid heat accumulation.

Transport, use and store the device within the range of allowed humidity and temperature.

Heavy stress, violent vibration or water splash are not allowed during transportation, storage and
installation.

Pack the device with standard factory packaging or the equivalent material when transporting the
device.
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1 Product Overview

The common networking mode for IPC is to connect IPC to PC via switch or router. The common
network mode is shown in Figure 1-1

B
Cable \Cable

Switch or Router

. W =

IPC PC

Figurel-1

Before you have access to network camera via the Internet, you need to acquire its IP address. Users
can search IP address of network camera via Quick Config Tool.



2 Initial Config

In this chapter it is to introduce the device initial config operation, which includes device initialization,
login device, log out WEB interface and password reset.

2.1 Device Initialization

It needs to implement device initialization when you use the device for the first time. Here it is to take
WEB operation as an example to introduce device initialization. You can also initialize device via Quick
Config Tool, NVR and platform etc.

Note

In order to guarantee device safety, please keep admin login password properly after device
initialization, and modify the password regularly.

Step 1

Open IE browser, input camera IP address in the address bar and click Enter.

The system will display the interface of Device Initialization after it is connected successfully, which is
shown in Figure 2-1

Note

The default IP address is 192.168.1.108.

Device Initialization

Username admin

Password The minimum pass phrase length is 8 characters

Confirm Password

Use a password that has 8 to 32 characters, it can be a combination of letter(s),
number(s) and symbol(s) with at least two kinds of them.(please do notuse

special symbols like"™;: &)

[v] Email Address
To reset password, please input properly or update in time.

Figure 2-1

Step 2
It is to set admin login password, please refer to Table 2-1 for more details.



Parameter Note
User name The default user name is admin
Password The password ranges from 8 to 32 digitals. It can contain letters, numbers
Confirm and special characters (excluding “”,*"",”,“” “&”) . The password shall
assword contain at least two categories. Usually we recommend the strong
P password.
Input an email address for reset password purpose. In case you forgot
Email password in the future, input the security code you got on the assigned
email to reset the password of admin.
Table 2-1
Step 3
Click Save.
The system will display the interface of Easy4iP, which is shown in Figure 2-2.
Easy4ip
V| Easydip

Register device to EASY4IP and then suitable for user to apply for cloud account. It can realize cloud service such as remote
surveillance, device record, alarm, cloud storage, using device to manage cloud.

Scan and Download EASY4IP APP

Next

Figure 2-2
Step 4
Select Easy4iP according to actual needs and realize Easy4iP registration for device, click next. The
system will display the interface of Online Upgrade, which is shown in Figure 2-3.



Online Upgrade

|v| Auto-check for updates
Notify automatically when updates available. The system checks for updates every day.
Online Upgrade is a service that provides you with firmware updates by cloud. This service will collect device information in order to

inform you about available firmware updates. Such information may include your device name, firmware version and device
identification numbers. Such information is processed for the sole purpose of informing you about firmware updates.

Save

Figure 2-3

Step 5

It is to set upgrade method according to the actual requirements.

Select Auto-check for upgrade and the system will check once daily automatically when there is system
upgrade prompt.

Note

After login, you can make setting in ‘Setup > System > Upgrade > Online Upgrade’.

Step 6
Click Save and device initialization is completed.

2.2 Login and Logout

Here it is to introduce device login and WEB interface logout via browser, it is to take IE Explorer 8 as

an example to make introduction.

2.2.1 Log in WEB Interface

Users can make operations such as live, playback and config upon the device after logging in device

WEB interface via browser.

Note

® |t can log in WEB interface after device initialization is completed.

® |t will prompt to install plug-in when logging in the system for the first time, please download and
install plug-in according to prompt.

Step 1

Open IE browser, input camera IP address in the address bar and click Enter button.



The system will display the Login interface after it is successfully connected, which is shown in Figure 2-
4.

IP Camera

Figure 2-4

Step 2

Input the password of admin user.

Step 3

Click Login.

It will display the Live interface after it logged in successfully, which is shown in Figure 2-5.

Note

Different devices have different functions with different interface display; please refer to the actual
interface for more details.



IP Camera

Main St supsieami | substeamz RRedTce

Figure 2-5

2.2.2 Logout

Click Logout and return to WEB login interface. After logging in the device WEB, the system will
hibernate automatically if it fails to operate the device for a period of time. It can recover to normal
working status quickly after entering password.

2.3 Reset Password

Users can reset password via reserved email when you forget the password of admin user.

Step 1

Open IE browser, input camera IP address in the address bar and click Enter button.

The system will display the Login interface after it is successfully connected, which is shown in Figure 2-
6.



IP Camera

Username: | admin

Password: I I Forgot password?

Login Cancel

Figure 2-6

Step 2
Click Forgot password?
The system will display the interface of Reset Password, which is shown in Figure 2-7.

Reset the password(1/2)
SN: 2C04ABIYAZ00019
QR code:
Note(For admin only):
Please use an APP to scan the left QR code to get
special strings. And then send the strings to
support_gpwd@htmicrochip.com.
The security code will be delivered to 1***@qq.com
Security code:
I Cancel I l Next I
Figure 2-7

Step 3

Reset login password.

Scan the QR code according to the interface prompt and acquire security code, then input the security
code which is received via your reserved email.



Caution

® Please use the security code to reset the password within 24 hours after you received the security
code via your reserved email. Otherwise the security code will be invalid.

® |f you fail to use security code for twice continuously, then the system will prompt that it fails to
acquire security code for the third time. It needs hardware to restore device default setting and
acquire security code again or wait for 24 hours and acquire it again if it needs to use the device
normally.

Step 4
Click next.
The system will display the interface where you can set the new password, which is shown in Figure 2-8.

Reset the password(2/2)

Username admin

Password

Use a password that has 8 to 32 characters, it
can be a combination of letter(s), number(s) and
symbol(s) with at least two kinds of them.
(please do not use special symbols like "™ ;: &)

Confirm Password

| Cancel I | Save I

Figure 2-8

Step 5

Reset Password and Confirm Password.

The password ranges from 8 to 32 digitals. It can contain letters, numbers and special characters
(excluding “”,“".%”“" “&”) . The password shall contain at least two categories. Usually we recommend
the strong password.

Step 6

Click Save and complete password reset.

The system will display the Login interface.



3 Live

After you logged in, you can see the live monitor window. See Figure 3-1.

IP Camera

1 Iiain St | _supsveam1 ) supsueamz [EIEESYTCP -] NNCR e Racy = N Pl A

—————T
|

Figure 3-1

There are four sections:

® Section 1: Encode setup bar

® Section 2: System menu

® Section 3: Window function option bar
® Section 4: Window adjust bar

3.1 Encode Setup

Note: Some series don’t support sub stream 2.
The encode setup interface is shown as in Figure 3-2

Sub Stream 1 Sub Stream 2 Eeddtdesd m

Figure 3-2

Please refer to the following sheet for detailed information.




Parameter

Function

Main stream

Click it to enable main stream video monitoring and click again
to disable it. Generally for storage and monitor.

Sub Stream 1

Click it to enable Sub Stream 1 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Sub Stream 2

Click it to enable Sub Stream 2 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Protocol

You can select stream media protocol from the dropdown list.
There are three options: TCP/UDP/Multicast

3.2 System Menu

System menu is shown as in Figure 3-3

Please refer to chapter 2 Live, chapter 3 PTZ, chapter 4 Playback, chapter 5 Setup, chapter 6 Alarm,

chapter 7 Log out for detailed information.

r Live

T PTZ

Figure 3-3

3.3 Video Window Function Option

The interface is shown as below. See Figure 3-1.

Figure 3-1
Please refer to the following sheet for detailed information.
SN Parameter | Function
1 Relay-out It shows if there is any alarm output, status description is as

follows:

® Red: means there is alarm output.

® Grey: means alarm is over.

Click on the button to force alarm to be on or off.

Fl,albar.:k T S:Etua T Alarm Lnﬁnut ]
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2 Digital ® When the video is in the original status, click it you can
Zoom select any zone to zoom in. In the non-original status,
you can drag the zoom-in zone in specified range. Right
click mouse to restore previous status.
® Click it; you can use the middle button of the mouse to
zoom in/out the video size.
3 Snapshot Click on the button to snapshot, save picture to path in Ch.
5.1.2.5.
4 Triple Click it to take snapshot upon the video at the frequency of
snapshot one picture per second. All images are saved to path in Ch
5.1.2.5.
5 Record Click it to record the video. All videos are saved to path in
Chapter 5.1.2.5.
6 Easy focus | Click it, you can see there are two parameters on the preview
video: AF Peak and AF Max.
AF Peak: It is to display the video definition during the focus
process.
AF Max: It is the most suitable value for the video definition.
The close the AF Peak and AF Max is, the better the focus
effect is.
7 Audio Turn on or off audio when you are monitoring.
8 Talk Click it to start or end bidirectional talk.
9 Help Click it to open help file.

3.4 Video Window Setup

The interface is shown as in Figure 3-2.

3.4.1 Image Adjustment

w0 = to it ©

ONONONONONONONO)

Figure 3-2

See Figure 3-3 for image adjustment.
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Figure 3-3

Click this button to display/hide image control interface. Click it to open picture setup interface. This
interface is on the top right pane.

Please refer to the following sheet for detailed information.

Parameter Function

Video It is to adjust monitor video Note:

setup brightness. ® All the operations here apply
to WEB end only.

® Please go to Setup-

m It is to adjust monitor video

contrastness. >Camera->Conditions to
E It is to adjust monitor video adjust corresponding items.
hue.

E It is to adjust monitor video
saturation.

Reset | Restore brightness,
contrastness saturation and
hue to system default setup.

3.4.2 Original Size
Click this button to go to original size. It is to display the actual size of the video stream. It depends on
the resolution of the bit stream.

3.4.3 Full Screen
Click it to go to full-screen mode. Double click the mouse or click the Esc button to exit the full screen.

12



3.4.4 Width and Height Ratio
Click it to restore original ratio or suitable window.

3.4.5 Fluency Adjustment

There are three levels of fluency for you to select (Realtime, Normal, and Fluency). The default is
normal.

3.4.6 Rules Info

Click the button, preview image will display intelligent rules after enabling; it is “enable” by default.
3.4.7 Zoom and Focus

Click this button and the focus zooming interface appears on the right of preview interface, as shown in

Figure 2-7, click left mouse button to adjust focus zooming configuration.

Note:

» The product series which support motorized zoom, synchronous focus and back focus have this
button.

« Auto-focus after zoom and focus adjustment.

3.4.8 Fisheye/Trigger Track

Click the button, installation mode and display mode interface will show up on the right of the preview

interface, see Figure 3-7 and Figure 3-8, single click to switch different installation modes and display

modes for fisheye, or switch different display modes for trigger track, it is enabled by default.

Note:

It is only supported by some models.

Zoom and Focus

Zoomin

Focus Speed m

B-—n
Near

Far

Auto Focus
Restore All
Refresh

Regional Focus

Figure 3-7
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Parameter | Function
Zoom Adjust the focal length of the lens by clicking or long pressing “+”“-’buttons.
The speed is used to adjust the length of one step during single click.
FocUs Adjust the sharpness of the lens by clicking or long pressing“+”. “-” buttons.
Step length is used to adjust the length of one step with one click.
Click to adjust the image definition automatically.
Auto- Note:
focus ' ) _
Other lens operations are not allowed during the process of auto-focus.
Reset the lens to zero position to eliminate the accumulative error of lens.
Reset All Note:
Please reset when the image adjustment is not clear or operating zoom focus many
times.
Refresh Synchronize the location of drag slider of lens and zoom focus after hardware zoom
focusing.
Regional Click it and use the mouse to select a zone, then the device can auto focus within the
Focus specific region.

In-ceiling Mount Wall Mount Ground Mount

Installation Mode Installation Mode
VA . VA
oL ‘|é A

2 -p?

Installation Mode

#a F

Display Mode

14



Figure 3-8

parameter

Note

Installation Mode

Three modes which are ceiling mount, wall mount and ground mount.

Display Mode

It represents the display mode of the current image (default supports original
image mode), the display modes may be different according to different
installation modes. It is shown as follows:

e Ceiling: 1P+1, 2P, 1+2, 1+3, 1+4, 1P+6. 1+8.

e Wall: 1P, 1P+3. 1P+4. 1P+8.

e Ground: 1P+1. 2P. 1+3. 1+4. 1P+6. 1+8,

Note:

The default displays original image mode when switching installation mode.

In-ceiling/Wall/Ground

O

image

It menas the original image without de-warpping

Original

In-ceiling/Ground

360°expanded rectangular panorama + independent
sub image, the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

1P+l

Two related 180° expanded rectangular pictures, two
subwindows form 360° panorama anytime, which is
also called “dual panorama”. Two expanded
op rectangular pictures both support left and right
movement starting point, which are also linked by
eachother.

il

Original image + 2 independent sub images, both the
H—‘ sub image and the subbox in the original image
Q

Q|

support zoom and movement. The original image also
1+2 supports changing starting point by rotation (no such
display mode for ground installation).

= Original image + 2 independent sub images, both the
Q sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

Original image + 4 independent sub images, both the
= sub image and the subbox in the original image

1+4 support zoom and movement. The original image also
supports changing starting point by rotation

15




parameter

Note

1P+6

360°expanded rectangular panorama +6 independent
sub image, both the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

5]

1+8

Original image + 8 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

Wall

Pad

1P

From left to right 180° expanded rectangular
panorama, which supports up and down movement
and changes vertical angle of view.

X
||

L 1P+3

180° expanded rectangular panorama+3 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

&
|

1P+4

180° expanded rectangular panorama+4 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

i

1P+8

180° expanded rectangular panorama+8 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

Display Mode

Al IR
.._..Il'

Figure 3-9

Enable the trigger track on the interface of tripwire or intrusion, and draw the rule of tripwire or intrusion,
the scene of trigger track window will change according to the moving object when it triggers rule alarm
until the moving object disappears from the view range of the camera. Please refer to “5.3.4 IVS” for
more details about the rules drawing and parameter config of tripwire and intrusion.

Trigger track includes three modes which are 1P, 1P+3 and 1P+5.
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° E 1P: Original picture

o .. 1P+3: Original picture and three trigger track windows, it can adjust the location and size of

three trigger track windows on the original picture.

o | 1P+5: Original picture and five trigger track windows, it can adjust the location and size of

five trigger track windows on the original picture.
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4 PTZ Control

Here you can view direction keys, speed, zoom, focus, iris, preset, tour, pan, scan, pattern, aux on, off
and PTZ setup button. See Figure 4-1.

Note:

Before PTZ operation, please make sure you have properly set PTZ protocol. (Please refer to Ch. 5.5.3).
Currently only IPC-HFXXXX series and —PT series products can support PTZ function.

Parameter Note

® PTZ supports eight directions: left/right/up/down/upper left/upper
right/bottom left/bottom right.

It controls rotation speed. The longer the step length, the higher the speed.
Step length control PTZ, zoom, focus and iris.

Use mouse to draw a box in monitoring video, PTZ will rotate and focus to
Quick Position | quickly positioning.

LS T S SN ST ST ST
(©)

11 TR 000

i 0®o0

000

speed(1-2): Y

© = ©

© O

©- 0

PTZ Settings

PTZ direction

Speed

E—

Figure 4-1
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©00
0®O0
000

speed(1-s) [E

© = ©

Q Focus e
© - O
PTZ Settings

[Scan ||

Figure 4-2

PTZ setting interface is shown as in Figure 4-3.
Here you can set scan, preset, tour, pattern, assistant function and light and wiper plus view coordinate.

4.1 Scan

Scan interface is shown in Figure 4-4.

PTZ Settings

Assistant
Light Wi

Figure 4-3
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PTZ Settings

Scan

P Start B Stop

2 Set

Set Left Set Right

Figure 4-4

Steps to scan are:

Set Left Set Right

Step 1. Click on Set button, display icon.

Step 2. Move via direction key to select left, click on Set Left to set left border of camera
Step 3. Move via direction key to select right, click on Set Right to set right border of camera.
Step 4. Complete scan path setup.

4.2 Preset

Preset interface is shown in Figure 4-5.
PTZ Settings

Figure 4-5

Steps to preset are:

Step 1. In preset box, input preset value.

Step 2. Click on Go to, camera rotates to preset position.

Step 3. Use direction key to rotate camera, and in preset box input preset value.
Step 4. Click on Add to add a preset. Range of preset relates to PTZ protocol.

4.3 Tour
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Tour interface is shown in Figure 4-6.

PTZ Settings

Tour v

P Start W Stop

Figure 4-6

Steps to tour are:

Step 1. In tour box, input tour path value.

Step 2. Click on Add. Range of tour relates to PTZ protocol.

Step 3. In preset box, input preset value.

Step 4. Click on Add as to add a preset in this tour. If click on Del, it deletes this preset in tour.
Note:

You can add more than one preset here, or delete more than one preset.

4.4 Pattern

Pattern interface is shown in Figure 4-7.

PTZ Settings

5
EZIETR

Figure 4-7

Steps to set pattern are shown as follows:

Step 1

Input pattern serial number value in the box, click “Add” and it will display “Start Rec” and “Stop Rec”.
Step 2

Click “Start Rec” to implement a series of operations such as zoom, focus, iris, direction and so on.
Step 3
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Click “Stop Rec” to complete the setting of a pattern path.
Step 4
Click “Start” and it will start pattern according to the pattern path which has been set; click “Stop” and

the pattern ends.

4.5 Assistant

Assistant interface is shown in Figure 4-8.

PTZ Settings

Figure 4-8

Steps to assistant are:

Step 1. In assistant box input assistant value.

Step 2. Click on Aux On to turn on aux function.
Click on Aux off to turn off aux function.

4.6 Light/ Wiper

Light wiper interface is shown in Figure 4-9.

PTZ Settings

Light Wiper -

Enable Disable

Figure 4-9

Steps to light wiper are:
® Click on Enable to enable light wiper function.
® Click on Disable to disable light wiper function.
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5 Playback

Web client playback supports video playback and picture playback.
Note:

Before playback, user shall set storage management as in Ch. 5.4.

5.1 Playback

The playback interface is shown as in Figure 5-1.

IP Camera (T ST TR TR T e
Fie Type

[S==E S SD Card |~

e < ETN

Sun Mon Tue Wed Thu Fri Sat

1
213|456 )7]8
9110 117121314 15

1617 /18 /192021 | 22

23 24 2526 27 28 29

20 [31)

Record Type Al General M Motion W Alarm Manual B

Figure 5-1

There are four sections:

Section 1: Function of play
Section 2: Playback file
Section 3: Play time cut
Section 4: Record type
Section 5: Progress bar
Section 6: Assistant function
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5.1.1 Function of Play
The function of play is shown as in Figure 5-2 and Figure 5-3.

OC0000 O =0

©Oe e 6 6 O 6-1

Figure 5-2

00000 O =0

e e 6 ©® O 62

Figure 5-3
Parameter Function
@ Pla When you see this button, it means pause or not played record. Click on this
y button, switch to normal play status.
2 Stop Click this button to stop playing.
Click on this button to go to next frame.
® Play by Note:
frame . .
You shall pause record when you use this function.
@ Slow Click on this button to play slowly.
® Quick Click on this button to play quickly.
. When this button displays, it means audio is silent. Click on this button to switch
® Silent
back to normal.
@ Volume Click on left mouse to adjust volume.
-1 Fisheve Click this button and fisheye device can adjust display mode according to
y different installation mode during the process of playback.
Click the button and it will playback and display intelligent rules and object
-2 Rule Info detection box if the video is equipped with intelligent rule info after the function is
enabled, it is off by default.
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5.1.2 Playback File
In calendar, blue date represents data currently has video record or snapshot. See Figure 5-4.

< 2013 S

Sun Mon Tue Wed Thu

Figure 5-4
Parameter Function
_ e Select “dav”, as video playback.
File Type . .
e Select “jpg” as picture playback.
Data Source Default is SD card.

Step 1. Click on data in blue, time axis displays record file progress bar in color. While, green represents
normal record, yellow represents motion detect record, red represents alarm record, and blue
represents manual record.

Step 2. Click on certain time on progress bar, playback starts from this time. See Figure 5-5.

Figure 5-5

Step 3. Click on file list = select date file will be displayed in list.

Step 4. Double click on file in list, playback this file and display file size, start time and end time.
See Figure 5-6.
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00 : 00 : 00 - 23 : 59 : 59 jfe}

Download Format @ dav © mp4

Start Time  File Type
15:49:39 O
15:50:07
15:54:38 8
16:25:13
16:31:35
16:32:06
16:45:58
16:54:00

1
2
3
4
5
6
7
8
9

OO0 000O0

17:00:54

I« €1/1 p pj (]
Begin Time:
End Time:
File Size:

Figure 5-6

Parameter

Function

ESearch

It means records within searched start time and end time on the date.

Record Format

There are two formats: dav, mp4.

mDownload

® Click the download button and download file to path in Ch. 5.1.2.5.

® System does not support download and playback at the same time.
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Parameter Function

& Back Click on back button to go to calendar interface.

5.1.3 Playback Cut

Note:

Playback cut function will automatically pause playing record as playback cut and playback cannot be at
the same time.

Step 1. Click on start time to cut on time axis. This time must be within progress bar range.

—_—

Step 2. Move mouse to cut icon 5;5 . You will be ask to select start time. Click on cur icon 5:5 as
finish cutting.

Step 3. Click on playback cut end time on time axis. This time must be within progress bar range.

[— [—
Step 4. Move mouse to cut iconﬂ you will be asked to select end time. Click on cut icon uﬂ as
finish cutting.

Step 5. Click on Save button to save file cut to path in Ch 5.1.2.5. See Figure 5-7.

00:00:00-00:00:00 B

Figure 5-7

5.1.4 Record Type

After checking record file type, only selected file will be displayed in progress bar and file list. Users can
also select the record type to be displayed via the dropdown box which is above the file list. See Figure
5-8.

RecordType Al [ General [ motion @ & Alarm ™ Manual W

Figure 5-8

5.1.5 Progress Bar
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@© zhr ©1hr | O30min

Figure 5-9

Parameter

Function

Oz4ir b4 hours

Click on it, means video in past 24 hours.

©zhr |, hours Click on it, means video in past 2 hours.
Oinr |, hour Click on it, means video in past 1 hour.
©30min 35 min Click on it, means video in past 30 min.

5.1.6 Assistant Function
Video playback assistant function is shown in Figure 5-10.

Figure 5-10

Parameter

Function

Digital Zoom

e Click on it, video in playback status if is in original size, user can
zoom in any area, If it is not in its original size, right click mouse to
restore its original size.

e Click on this button, you can scroll to zoom in.

E] Snapshot

Click on this button, you can snapshot video under playback status.
Snapshot will be saved to path in Ch. 5.1.2.5.

5.2 Picture Playback

Web client picture playback interface has the following three functions:

Parameter Function

1 Play function bar
2 Playback file bar
3 Snapshot type bar

See Figure 5-11.
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IP Camera

[>)

Snapshot Type All General W Event M Alarm

5.2.1 Play

Live e (LT (TR S —" —r—

Figure 5-11

oo

Figure 5-12

©)

File Type ipg E

Data Src _SD Card E
< IEGE >

Sun Mon Tue Wed Thu Fri Sat
1 213|456 )7
89101112013 ]14

7 [48) [49] 20 [21]
241251262728

31

Default icon is E and it means pause or not played picture. Click on play button to switch to

normal play status. lcon become m

Click on it to pause.
5.2.2 Playback File
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< 2013 I8

Sun Mon Tue Wed Thu Fri Sat

Figure 5-13

Step 1. Click on file list = , select snapshot file of the date.

Step 2. Double click on file in list, to play this snapshot.

Parameter

Function

E Search

It means all snapshot files within the start time and end time of selected date.
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Parameter Function
m Click the download button to open snapshot file or directly download to local
Download according to the browser types.
€« Back Click on back button to return to calendar interface and re-select time.

5.2.3 Snapshot Type

00 : 00 : 00 - 23 : 59 : 59 jfe}

Start Time  File Type

13:23:16
13:24:55
13:25:09
13:25119
13:25:29
13:25:40
13:25:50
13:26:09
13:26:19
13:27:41
13:27:51
13:28:01

M <€1/1p P

©
©
©
©
©
©
o
= O
©
©
©
©
o

Figure 5-14
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After checking snapshot file type, in file list only display file of selected type. Users can also select the
snapshot type to be displayed via the dropdown box above the file list. See Figure 5-.

Snapshot Type All General Event W Alarm

Figure 5-15
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6 Setup

Web client setup support camera, network, time, storage, system and system info view.

6.1 Camera

The camera setting includes conditions, profile management, zoom and focus.

6.1.1 Conditions

Note:

The camera parameter may be different according to different models, please refer to the actual product
for more details.

6.1.1.1 Picture

Note:

The device which supports true WDR fails to support long exposure when true WDR is enabled.

Step 1

Select “Setup > Camera > Conditions > Picture” and the system will display the “Picture” image which is
shown in Figure 6-1.

IP Camera

Conditions  JProfile Management§ Zoom and Focus

> Video

Profile| Day [~]

g Style Standard B

» Exposure

> Audio

Network Brightness [=] O
Event » Backlight Contrast (=] O
Saturation (=] 0 50

Storage » WB

System
Y » Day & Night ]
Information
» IR Light Gamma (5]

Mirror ) ON @ OFF

Flip 0° [+]

Default I | Refresh I l Save

Figure 6-1
Step 2
Set picture parameters; please refer to the following sheet for more details about parameter setting.
Parameter Note
Style It is to set the picture style, which includes standard, soft and vivid.
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Parameter

Note

Brightness

It is to adjust the image overall brightness via linear adjustment mode.
The larger the number is, the brighter the picture is, and on the contrary it
is opposite. The picture get blurry easily when the value is set too big.

Contrast

It is to adjust the picture contrast. The bigger the value is, the bigger the
bright contrast becomes, and on the contrary it is smaller. The dark area
becomes darker and the bright area becomes overexposed easily when
the value is set too big. The picture becomes blurry when the value is set
too small.

Saturation

It is to adjust the color darkness and lightness. The color becomes darker
when the value is bigger; on the contrary it becomes lighter. The value
causes no influence to the overall brightness of the image.

Sharpness

It is to adjust the sharpness level of the picture edge. The bigger the
sharpness value is, the more obvious the image edge becomes, the image
is likely to generate noise more easily when the value is set too big.

Gamma

It is to change image brightness and improve the dynamic display range of
the image via nonlinear adjustment mode. The bigger the value is, the
brighter the picture becomes, and on the contrary it is opposite.

Mirror

After mirror is enabled, the monitoring image will be displayed invertedly.

Flip

It is to change the display direction of the monitoring image.
It includes following options:
e Normal: The monitoring picture is normally displayed.

e Flip mode 1: The monitoring picture is displayed with clockwise
rotation 90°

e Flip mode 2: The monitoring picture is displayed with anticlockwise
rotation 90°

e 180°: The monitoring picture is displayed upside down.
Note:

Please set the video resolution as 1080P or lower when applying flip mode
for some devices.

EIS

It can realize electronic anti-flicker function via comparison algorithm of
image difference, which can effectively solve the problem of image jittering
during application and it can make the image clearer.

Step 3

Click “Save” and complete the image parameter config of the camera.
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6.1.1.2 Exposure

Step 1

Select “Setup > Camera > Conditions > Exposure”. The system will display the “Exposure” interface
which is shown in Figure 6-2.

IP Camera

1 Zoom and Focus

[ conauons ___| = =
> Video

> Audio » Picture Anti-flicker Outdoor

Network Sl —— ? - Mode | Auto [+]
Event = - » Backlight

- AutoIris @ ON ) OFF
storage k » W8
A 3DNR @ ON OFF
System » Day & Night
7 z Al Grade (] 0 50
Information » IR Light

Figure 6-2
Step 2
It is to set the exposure parameter, please refer to the following sheet for more details.

Parameter Note

® QOutdoor: You can switch to exposure mode when it is in
outdoor mode, it can realize the result in the corresponding
exposure mode.

® 50Hz: When the current is 50Hz, system can auto adjust the
Anti-flicker exposure according to the environment brightness in case
there is any stripe.

® 60Hz: When the current is 60Hz, system can auto adjust the
exposure according to the environment brightness in case
there is any stripe.




Parameter

Note

Mode

It is the camera exposure mode.
Note:

® When “Anti-flicker” is “Outdor”, the “exposure mode” can be
set as “gain priority” or “shutter priority” mode.

® Different devices have different exposure modes; please
refer to the actual interface.

It includes the following options:

® Auto: It can auto adjust the image brightness according to
the environment.

® Gain priority: The device can auto adjust according to the
gain range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the gain value has reached to upper limit
or lower limit, which is to make the image reach the best
brightness.

® Shutter priority: The device can auto adjust according to the
shutter range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the shutter value has reached to upper
limit or lower limit, which is to make the image reach the best
brightness.

® Iris priority: Iris value is fixed, the device can auto adjust the
shutter value if the image brightness fails to reach effect and
the shutter value has reached the upper limit or lower limit,
the device can auto adjust the gain value to make the image
reach the best brightness.

® Manual: It is to manually set gain value and shutter value,
adjust the the displayed brightness of the image.

Auto Iris

It can set the parameter when the camera installs auto iris.

® The lens iris can auto adjust the size according to the
environment after auto iris is enabled, then the image
brightness will change accordingly.

® The iris value reaches the max when disabling auto iris, the
lens iris will not change according to the environment
brightness.

3D NR

It is to process the image with multiframe (at least two frames), it
can realize noise reduction of the image by using the interframe
information between the previous and latter frame.

Grade

It can set the parameter when “3D NR” is enabled.
The bigger the grade is, the better NR effect it can realize.
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Step 3
Click “Save” to complete the parameter config of camera exposure.

6.1.1.3 Backlight

Backlight mode can be divided into BLC, WDR and HLS.

BLC: it can avoid cucoloris phenomenon of the darker area in the backlight environment.

WDR: It can suppress the overbright area and compensate darker area by enabling WDR, which can
make the overall image clear.

HLC: It is to weaken the high light, which can be applied in the areas such as toll gate, entrance and exit
of the parking lot and etc. As for extreme light, it can snapshot the human face in the dark environment
and it can realize better effect for the details of the plate number.

Step 1
Select “Setup > Camera > Condition > Backlight”, the system will display the interface of “Backlight”
which is shown in Figure 6-3.

IP Camera

Profile Normal
5 ifaduce Wode | OFF []
Network = i - » Exposure
Storage ; = - » WB
System 4 » Day & Night
Information F » IR Light
| Default l | Refresh | | Save |
Figure 6-3

Step 2

Set the backlight parameter.

® \When the “Mode” is set as “Scene Self-adaptation”, the system will auto adjust the image
brightness according to the environmental brightness, which is to make the object display clearly in
the scene.

® When the “Mode” is set as “BLC”, it can select default mode or customized mode.

€ When selecting “Default” mode, the system can realize auto exposure according to the
environment, which is to make the image in the darkest area clear to be seen.
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€ When selecting “Customized” mode, the system can realize exposure upon the selected area
after it set customized area, which is to make the image of the selected area reach
appropriate brightness.
® When the “Mode” is set as “WDR”, it will lower the brightness of the area with high brightness and
enhance the brightness of the area with low brightness, which is to make the objects in both high
brightness and low brightness area display clearly.
Note:
There may be video loss of a few seconds when the camera is switched from non WDR mode to WDR
mode.
® When the “Mode” is set as “HLC”, the system will constrain the brightness of the area with high
brightness and decrease the size of the halo area, which is to lower the brightness of the whole
image.
Step 3
Click “Save” to complete the config of the backlight mode.

6.1.1.4 WB

WB is used to restore the white object in the scene by the camera, after WB mode is set, it can make
the white object look white in different environments.

Step 1

Select “Setup > Camera > Conditions > WB”, the system will display the interface of “WB”, which is
shown in Figure 6-4.

IP Camera

q Zoom and Focus
S ¥ TR Profile. Normal [~]
> Video ' 1 A

e
] i
> Audio i bitiaue Mode | Auto [Zt

Network EETa Bl - 2 » Exposure
Event 5 —— » Backlight
Storage v

» Day & Night

System

Information » IR Light

| Default I | Refresh | \ Save |

Figure 6-4
Step 2
Set WB mode.
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® When the “Mode” is set as “Auto”, the system can auto compensate white balance upon different
color temperatures, which is to make the image color normal.

® When the “Mode” is set as “Natural”, the system can auto compensate white balance to the scene
without artificial light, which is to make the image color normal.

® When the “Mode” is set as “Street Lamp”, the system can auto compensate white balance to the
outdoor scene at night, which is to make the image color normal.

® \When the “Mode” is set as “Outdoor”, the system can auto compensate white balance to the most
outdoor scenes with natural light and artificial light, which is to make the image color normal.

® \When the “Mode” is set as “Manual”, it can manually set the value of red gain and blue gain; the
system can compensate the different color temperatures in the environment according to the
settings.

® \When the “Mode” is set as “Regional Custom”, it is to set customized area, the system can
compensate white balance to different color temperature of the images in the area, which is to
make the image color normal.

Step 3
Click “Save” to complete the config of WB mode.

6.1.1.5 Day & Night

It is to set the switch between color mode and black & white mode.

Step 1

Select “Setup > Camera > Conditions > Day & Night” and the system will display the interface of “Day &
Night”, which is shown in Figure 6-5.

IP cCamera

2 Profile | Normal
> Video

> Audio bl bgace Mode | Auto

[]
[]
Sensitivity| Middle EI

Network o e : - B Bxposure
Event — » Backlight Delay | 6S
Storage - » WB

System

» Day & Night

» IR Light

Information

l Default I | Refresh | | Save |

Figure 6-5
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Step 2

Set day & night parameter; please refer to the following sheet for more details.

Parameter

Note

Mode

It is to set the camera image displayed as color or black & white mode.

Note:

The setting of “Day/Night Mode” is not affected by the setting of “Profile

Management”.

It includes the following options:

® Color: The camera image is displayed as color image.

® Auto: The camera can auto select color image or black & white image
to be displayed according to the environmental brightness.

® Black & white: The camera image is displayed as black & white image.

Sensitivity

The parameter can be set when the “Day/Night Mode” is “Auto”.
It is to set the sensitivity of the switch between image color display and
black & white display.

Delay

The parameter can be set when the “Day/Night Mode” is “Auto”.
It is to set the switch delay between image color display and white & black
display. The smaller the delay is, the faster of the switch becomes between

color display and black & white display.

Step 3

Click “Save” to complete the config of day/night mode.

6.1.1.6 Defog

The image quality will become weak when the device is in the environment with fog or haze, you can
enable defog function to adjust the image definition.

Step 1

Select “Setup > Camera > Conditions > Defog” and the system will display the interface of “Defog”
which is shown in Figure 6-6.
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IP Camera

Profile Day
>

> Audio . e Mode OFF [+]
Network e P o N - » Exposure

Event S » Backlight

Storage y ] » WB

System » Day & Night

= :
. b 3

Figure 6-6

Step 2

It is to set defog mode according to the actual scene.

® \When the “Mode” is set as “Manual’, it is to manually set intensity and air light mode, the system
will adjust the image definition according to the intensity and air light mode which have been set
previously. As for air light mode, you can set manual or auto.

® \When the “Mode” is set as “Auto”, the system will auto adjust the image definition according to the
actual scene.

® When the “Mode” is set as “Off”, then the defog function is disabled.

Step 3
Click “Save” to complete the config of defog mode.

6.1.1.7 IR Light

You can directly set the mode of IR light if the device is equipped with IR light.

Step 1

Select “Setup > Camera > Conditions > IR Light” and the system will display the interface of “IR Light”
which is shown in Figure 6-7.
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IP Camera

> Profile. Normal
> Video

B
> Audio : e Mode | SmartiR [~]
Network e = — » Exposure
Event — f — » Backlight

o ===
Storage = » WB

System » Day & Night

Information - » IR Light
. P -
.

| Default J | Refresh | ‘ Save |

Figure 6-7
Step 2
Itis to set IR light mode according to the actual scene.
® \When the “Mode” is set as “Manual’, it can manually set the brightness of IR light; the system will
realize light compensation to the image according to the IR light intensity.
® When the “Mode” is set as “Smart IR”, the system can adjust the light brightness according to the
actual scene.
® \When the “Mode” is set as “Zoomprio”, the system can auto adjust the IR light according to the
brightness change of the actual scene.
€ The system will enable near light by priority when the actual scene becomes dark, the system
will enable the far light when the near light fails to meet the requirement of scene brightness
even if it is adjusted to the brightest.
€ The system will adjust far light brightness by priority to off and then adjust the brightness of
near light when the actual scene becomes bright. The system will always disable far light
when the focal length of the lens is adjusted to a certain wide angle, which is to avoid near
overexposure. Meanwhile, it can manually set light compensation to slightly adjust the
brightness of IR light.
® \When the “mode” is set as “Off”, it will not enable the IR light.

Step 3
Click “Save” and complete the config of IR light.

6.1.1.8 Profile Management

Step 1

Select “Setup > Camera > Conditions > Profile Management” and the system will display the interface of
“Profile Management”.
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Step 2

Set profile management.

® \When the “Profile Management” is set as “Normal”, the system will monitor according to the normal
config.

IP Camera

Camera Conditions Profile Managementl| Zoom and Focus

. Profile Management ¢ Normal ¢ Full Time ¢ Schedule
> Video

> Audio Default | | Refresh I | Save
Network

Event
Storage

System

Figure 6-8
® When the “Profile Management” is set as “Full Time”, you can select “Always Enable” in “Day” or
“Night’, the system will monitor according to the config of “always enable”.

IP camera

Camera Conditions Profile Managementl]  Zoom and Focus

Profile Management € Normal  Full Time ¢ Schedule
> Video

Always Enable Day =
> Audio

Network | Default I | Refresh | l Save

Event
Storage

System

Information

Figure 6-9
® \When the “Profile Management” is set as “Schedule”, you can set some period as day and another
period as night, for example, if it sets 0:00~12:00 as day, 12:00~24:00 as night, then the system will
monitor by adopting corresponding config in different periods.

IP Camera e e e R e

Conditions Profile Management]  Zoom and Focus @

n Profile Management ¢ Normal € Full Time @ Schedule
> Video

> Audio

Network Period setting U ‘:.

0:00 4:00 8:00 12:00 16:00 20:00 24:00

Event
Storage EDay M Night

SYBo [ peut || Remesn ]| Save |

Information

Figure 6-10
Step 3
Click “Save” to complete the settings of profile management.
Note:

Click “Default” to restore the device to default config; click “Refresh” to check the latest config file of the
device.
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6.1.1.9 Zoom and Focus

Note:

Only motorized vari-focal devices support focus and zoom function.

Step 1

Select “Setup > Camera > Conditions > Zoom and Focus” and the system will display the interface of
“Zoom and Focus” which is shown in Figure 6-11.

IP Camera

Camera Conditions
> Video

> Audio

Network

Event

Storage

System

Information

zoom wiDE (=) () . TELE Speed [20 ~ Restore All
Focus NEAR (=) (& FAR  Speed [20 ~] | C+3AutoFocus Refresh

Figure 6-11

Step 2

Adjust the focal length of the lens.

After it is zoomed, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.

Step 3

Adjust the lens definition.

After it is focused, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.

Note:

® Speed is used to set the length by pressing “+” and “-“.

® After adjusting the focal length of the lens or click “Auto Focus”, the device will auto adjust the
image definition, it is not allowed to implement other lens operation during auto focus.

® After several times of zoom and focus, the image fails to be adjusted clear, click “Restore All’ to
reset the lens to zero and remove the accumulative error of the lens.

® Click “Refresh” and the device will automatically synchronize the hardware to the location of sliding
block of lens zoom and focus.

6.1.2 Video
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6.1.2.1 Video

Step 1

Select “Setup > Camera > Video > Video” and the system will display the interface of “Video” which is
shown in Figure 6-12 or Figure 6-13.

IP Camera

Video Snapshot Overlay Path

> Conditions

Video Main Stream Sub Stream
Network Enable Sub Stream 2 v
Event Encode Mode H.264H v Encode Mode H.264H v
Storage Smart Codec OFF v ® Resolution D1 (704*480) v
System Resolution 2304x1296 (2304*1296 v Video Clip
Information Frame rate(FPS) 30 v Frame rate(FPS) 6 Y
Bit Rate Type CBR v Bit Rate Type CBR v
Reference BitRate  1792-10240Kb/S Reference BitRate  48-896Kb/S
Bit Rate 6144 v Bit Rate 896 v
| Frame Interval 60 (30~150) | Frame Interval 12 (6~150)

«! Watermark Settings

Watermark Character | Digital CCTV

Default I I Refresh I I Save

Figure 6-12 (Non fisheye)

IP Camera

Video

Snapshot

2:Codiions Installation Mode Ceiling E
—— Record Mode 2P El
Network Main Stream Sub Stream
Event [¥] Enable Sub Stream 1 [+]
Storage Code-Stream Type | General [~] Code-Stream Type | General =]
System Encode Mode H.264 E Encode Mode H.264 E]
Information T 2432x0432 (24322432 ] Resolution 640640 (640'640)  [~]
Frame rate(FPS) 15 EI Frame rate(FPS) 15 E]
Bit Rate Type CBR El Bit Rate Type CBR E]
Reference BitRate  2048-11008Kb/S Reference BitRate ~ 256-1792Kb/S
Bit Rate 8192 [+] Bit Rate 1024 []
| Frame Interval 30 (15~150) | Frame Interval 30 (15~150)
sve 1(off) = sve 1(of) [~]
[v] watermark Settings
Watermark Character | Digital CCTV
Default | l Refresh | [ Save

Figure 6-13 (Fisheye)
Step 2
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Set video bit stream, please refer to the following sheet for more details about the parameters.

Parameter

Function

Installation Mode

It will display the parameter when the device is fisheye.
There are three installation modes for fisheye which are
ceiling, wall mount and ground installation, please
select installation mode according to the actual
installation scene of the fisheye.

The system will begin to switch after switching
installation mode, it will prompt successfully saved after
it is switched successfully.

Note:

The device end will output the dewarped video stream
after configuring installation and record mode, when the
device is accessed to third-party platform, it will directly
display the dewarped image on the third-party platform.

Record Mode

It will display the parameter when the device is fisheye.

The system will begin to switch after record mode is

switched, it will prompt saved successfully after it is

switched successfully.

The record mode will change according to the different

installation modes.

® 10: the original picture which is not dewarped.

® 1P: 360°rectangular panorama.

® 2P: The mode can be set when the “Installation
Mode” is set as “Ceiling” or “Ground”. It is the 2
related 180°rectangular image, the two
subwindows can both form 360°panorama anytime.

® 10+3R: original image + 3 independent sub
images, both the sub image and sub boxes in the
original image can support zoom and movement.

® 1R: Original image + independent sub image, the
sub boxes of the original image support zoom and
movement.

® 4R: original image + 4 independent sub images,
both the sub image and sub boxes in the original
image support zoom and movement.

® 2R: Original image + 2 independent sub images,
the sub boxes of the original image can support
zoom and movement, the sub image supports up
and down movement, which can change the
vertical angle of view.

Note:

The device end will output dewarped video stream after

configuring installation and record mode, when the

device is accessed to the third-party platform, it will

directly display the dewarped image on the third-party

platform.
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Parameter

Function

Sub Stream Enable

Select “Enable” to enable sub stream.
The device supports enabling sub stream 1 and sub
stream 2 at the same time.

Smart Codec

It can enhance image compression performance and
reduce storage space by enabling intelligent encoding.
Note:

After intelligent encoding is enabled, the device will not
support third stream, ROI or intelligent event detection,
please refer to the actual interface for more details.

Code-Stream Type

ACF means using different fps to record.

There are two options: VBR and CBR.

Please note you can set video quality in VBR mode.
Note:

WEB interfaces don’t support motion detect and alarm
code stream setting.

Encode mode

There are five options: H.264 (main profile standard,

H.264H (high profile standard), H.264B (Baseline

Profile), H.265 (main profile standard) and MJPEG

encode.

® The H.264, H.264H both are H264 bit stream.
H.264 is the Main Profile encode and you need to
enable the sub stream function in your camera and
set the resolution as CIF. Then you can monitor via
the Blackberry cell phone.

® The H.265 is the main profile encode mode.

® MJIPEG: In this encode mode, the video needs to
large bit stream to guarantee the video definition.
You can use the max bit stream value in the
recommend bit to get the better video output effect.

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Note: When video is under rotating status, you cannot
set resolution higher than 1080P (excluding 1080P).

Video Clip

The function is only supported by sub stream 2, please
refer to “Video Clip” for more details below the sheet.

Frame Rate (FPS)

PAL: 1~25f/s, 1-50f/s NTSC: 1~30f/s or 1~60f/s.
The frame rate may vary due to different resolutions.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.
Under MJPEG mode, only CBR is available.

Recommended Bit

Recommended bit rate value according to the resolution
and frame rate you have set.
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Parameter

Function

Bit Rate

® |n CBR, the bit rate here is the max value. In
dynamic video, system needs to low frame rate or
video quality to guarantee the value.

® The value is null in VBR mode.

® Please refer to recommend bit rate for the detailed
information.

SVC

Frame rate can be encoded by layer. It is a flexible
encoding method. By default, itis 1 as 1 layer. You also
can set 2/3/4 layers.

| Frame

Here you can set the P frame amount between two |
frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.

Watermark Settings

Select “Watermark Setting” and enable watermark
function. After the watermark function is enabled, you
can check if the video is tampered via verifying
watermark character.

Watermark Character

It is the character of watermark verification, it is
DigitalCCTV by default.

® Video Clip

1. Select “Sub Stream 2” in the drop-down box, click “Enable”.

2. Enable “Video Clip”, click 24

The system will display the interface of “Area”, which is shown in Figure 6-14.
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Resolution

D1 (704%480)

=]

Save

Cancel

Figure 6-14

Select the needed resolution and clip the needed image on the interface, which is shown in Figure

6-15.

Click “Save”. You can check the clipped video in the preview interface (the sub stream 2 preview
interface only displays the clipped area), which is shown in Figure 6-15.
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IP Camera

AT
m Sub Stream 1 Protocol nj

Figure 6-15

Step 3
Click “Save” to complete video stream setup.

6.1.2.2 Snapshot
The snapshot interface is shown as in Figure 6-16.

IP Camera

Video Snapshot
> Conditions

> Audio

Snapshot Type \Gener@l
Image Size 1080P (192071080)

Quality |5
Network S

Interval v
Event

Storage I Default l | Refresh | l Save.

System

Figure 6-16

Please refer to the following sheet for detailed information.
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Parameter Function

Snapshot type There are two modes: general (schedule) and Event (activation).
Image size It is the same as the resolution of main stream.

Quality It is to set the image quality. There are six levels.

Interval It is to set snapshot frequency. Optionall~7s/picture, customized.

6.1.2.3 Video Overlay
The video overlay interface is shown as in Figure 6-17.

IP Camera

O EURYEEG] (O Enable @ Disable

» Channel Title
> Audio

Network » Time Title
Event : - ' o = » Text Overiay
Storage B » Picture Overlay
System » Counting
Information

|' RemoveAl || Delete | (OrRightick)

| Defauit | | Refresh ‘ | Save

Figure 6-17
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IP camera

Snapshot
> Conditions

Spm— » Time Title
Network P

Event 5 < 4 » Text Overlay

Storage V. » Picture Overlay

System 4 » Counting
Information

» Privacy Masking @ Enable () Disable

]

IPC

Figure 6-18

IP Camera

Snapshot Overlay

> Conditions

> Audio

» Privacy Masking

» Channel Title

Network

Event » Text Overlay

Storage » Picture Overlay

System » Counting

Information

Default | | Refresh ‘ | Save

Path

® Enable Disable

Week Display

Figure 6-19
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IP Camera

> Conditions 2 2
» Privacy Masking

(O Enable @ Disable

- E » Channel Title Input Text:
> io I
Network —— » Time Title
e IS
Event : ‘ -~ [
Storage 4 » Picture Overlay
System ' » Counting
Information
Text Align
Right [=]

IP Camera

> Conditions

» Privacy Masking () Enable © Disable

» Channel Title Picture Preview:
> Audio !
» Time Title
Network : 3 : "
. T Te
. - 55 » Text Overlay
oy s » Counting
Information
Upload Picture

Requirement for picture upload
1. Max size is 16k.

2. Max resolution is 128x128 pixels.
3. 256 colors, bmp format.

Figure 6-21
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IP Camera

Snapshot

> Conditions

> Audio

| » Privacy Masking ) Enable © Disable
" » Channel Title Statistics Type
B ) Time Title [v] Enter Number

Network o
» Text Overlay [v] Leave Number
Event

i Text Al
Storage = » Picture Overlay ign

” Left

Information

Figure 6-22

Please refer to the following sheet for detailed information.

Parameter Function

Privacy Masking ) Herg you can privacy mask the specified video in the
monitor video.

® System max supports 4 privacy mask zones.

Time Title ) _You can.engble' this fqnction so that system overlays time
information in video window.

® You can use the mouse to drag the time tile position.

Channel Title ® Youcan .enable t_his _fun(_:tion so that system overlays
channel information in video window.

® You can use the mouse to drag the channel tile position.

Text Overlay ) Y(_)u can enable this function to overlay text in video
window.

® You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.

Picture Overlay ° Yo_u can e.nable this fun_ction to display overlay picture.
Click on disable to turn it off.

® Click on Upload Picture to overlay local picture into
monitoring window. You can drag the yellow box to move
it.

Note:

You cannot enable text and picture overlay at the same time.
Counting ® Check “Enable” to display the counting statistics data in
the video monitoring window; check “Disable” not to

display.
® There are enter number and leave number for statistics
type and left align and right align for OSD info.
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Refresh ® Set privacy mask, channel title, time title, location, overlay
and save the change. You can click on Refresh to see

effect.
Default ® Click it to restore default config.
Save ® Click it to complete video settings.

6.1.2.4 ROI
Note: Some series don’t support ROI setup function.

IP Camera

Camera Snapshot
> Conditions

> Audio

Enable ¢ Disable
Image Quality | 6(best) v
Network
Event
Storage
System

Information

[ Remowean | Deete |orRightclick)

| Default | \ Refresh [ | Save

Figure 6-23

IP Camera

Camera

Snapshot
> Conditions

> Audio

Enable ' Disable

Image Quality |6(best) ¥
Network
Event
Storage
System

Information

Remove All Delete {Or Rightclick )

I Default ” Refresh | i Save
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Figure 6-24

Parameters | Note
Enabl Check “Enable”, then it will display the ROI in the video monitoring window;
nable
Check “Disable”, then it won’t display.
e Set the image quality of ROI, ranging from 1~6, default is 6.
Image Note:
Quality For fisheye device, it ranges from 1~6 (best), default is 6 (best)
e Able to set area block, max 4 areas.
6.1.2.5 Path

The storage path interface is shown as in Figure 6-25.

Here you can set snap image saved path and the record storage path.

® The default monitor image path is C:\Users\admin\WebDownload\LiveSnapshot.

® The default monitor record path is C:\Users\admin\WebDownload\LiveRecord.

® The default playback snapshot path is C:\Users\admin\WebDownload\PlaybackSnapshot.
The default playback download path is C:\Users\admin\WebDownload\PlaybackRecord.

The default playback cut path is: C:\Users\admin\WebDownload\VideoClips.

Note:

Admin is locally logged in PC account.
Please click the Save button to save current setup.

IP Camera

> Audio
Network
Event
Storage
System
Information

6.1.3 Audio

AT SN N SR TN AT

Video

Snapshot

Live Snapshot C:\Users\admin\WebDownload\LiveSnapshot Browse...

Live Record C:\Users\admin\WebDownload\LiveRecord Browise...

Playback C:\Users\admin\ Download\PlaybackSnapshot Browise...

Playback Download  C:\Users\admin\WebDownload\PlaybackRecord Browse...

Video Clips C:\Users\admin\WebDownload\VideoClips Browse...
petaut__ ][ saw

Figure 6-25

Please note some series devices do not support audio function.

6.1.3.1 Audio

The audio interface is shown as below. See Figure 6-26.

56



IP Camera

Camera Audio
> Conditions
> Video Encode

- Audio Main Stream
Network V] Enable
Event Encode Mode G.711A [+]
Storage Sampling Frequency | 16k E]
System
) Sub Stream
Information -
[T} Enable Sub Stream 1 [+]
Encode Mode G.711A E
Sampling Frequency | 16k E]
— Aftribute
Audioln Type Lineln El
Noise Filter Enable [~]
Microphone Volume [=] O 50
SpeakerVolume  [=] 0 50
peraut__ | Remesn || |

Figure 6-26
Please refer to the following sheet for detailed information.
Parameter Function
Enable You can enable audio only when video is enabled.

After selecting the “Enable” of main stream or sub stream, the
network transmission stream is the audio/video composite
stream, otherwise it only includes video image.

Encode mode

The encode mode of the main stream and extra stream include
G.711A, G.711Mu, G.726 and ACC. The default mode is
G.711A.

The setup here is for audio encode mode and the bidirectional
talk encode both.

Sampling
Frequency

The sampling frequency of audio. It includes the following
options:

® 8K

® 16K
® 32K
® 48K
® 64K
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Audioln Type Two modes to select: Lineln, Mic. Device needs to connect
external audio input source under Lineln mode, and it doesn’t
need to connect external audio input source under Mic mode.

Noise Filter Enable the function and it can filter relevant noise.
Microphone Adjust microphone volume from 0~100.
Volume Note:

Supported by some devices.

Speaker Volume | A it speaker volume from 0~100.

Note:
Supported by some devices.

6.1.3.2 Alarm audio

IP Camera

Alarm Audio
> Conditions
2:Mde0 alarm1.pcm
_ Audio o alarm2.pcm
Network
Event
Storage
System

Information

Figure 6-27
Add Audio File X
= Record = Upload
Audio File | pcm
Recaord
Figure 6-28

Audio management currently supports PCM format to record and PCM, wav two forms to upload,
and can select an audio file for the audio alarm linkage.
The way to download the web alarm playback audio file into local is as follows:
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Step 1 Use the left mouse button to click the hollow circle " in the “choice” column on the left,

and shows = , which means effective choice of alarm audio.

Step 2 Use the right mouse button to click : , select “save target as” to download.

6.2 Network

6.2.1 TCP/IP

The TCP/IP interface is shown as in Figure 6-29. It supports IPv4 and IPv6. IPv4 supports static IP and
DHCP. IPv6 supports static IP only. When users manually modify IP address, WEB will automatically
jump to the new IP address.

IP Camera

Camera TCPIIP
N
> Connection Ethemet Card Wire(DEFAULT) [+]
> PPPoE Mode © Satic ) DHCP

Host Name

IPC

> DDNS MAC Address

> IP Fiter 1P Veersion 1Pv4 [=]
> SMTP(Email)

> Multicast

IP Address 0 . 15 . 1 . 171
BLEF Subnet mask 255 .255. 0 . 0
> SNMP
Default Gateway 0 .15 . 0 . 1
> Bonjour
Prefered DNSServery 8 . 8 . § . 8
4

3 8021x Altemate DNS Server| 8 . 8 . 4 .

> QoS Enable ARP/Ping to set IP address service
05

Event Default ‘ ‘ Refresh | | Save
Storage

System

Information

Figure 6-29
Please refer to the following sheet for detailed information.
Parameter Function
Host Name It is to set current host device name. It max supports 15
characters.
Ethernet Card Please select the Ethernet port. Default is wired.

Please note you can modify the default Ethernet card if there is
more than one card.

Mode There are two modes: static mode and the DHCP mode. Select
DHCP mode, it auto searches IP, and you cannot set IP/subnet
mask/gateway. Select static mode, you must manually set
IP/subnet mask/gateway.

Mac Address It is to display hose Mac address.
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IP Version It is to select IP version. IPV4 or IPV6.
You can access the IP address of these two versions.
IP Address Please use the keyboard to input the corresponding number to

modify the IP address and then set the corresponding subnet
mask and the default gateway.

Preferred DNS

DNS IP address.

Alternate DNS

Alternate DNS IP address.

Enable
ARP/Ping set
device IP

address service.

You can use ARP/Ping command to modify or set the device IP
address if you know the device MAC address.

Before the operation, please make sure the network camera
and the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the network camera and the PC
in the same LAN.

Step 2: Get the physical address from the label of the network
camera.

Step 3: Go to the Run interface and then input the following
commands.

arp —s <IP Address> <MAC>

ping —I 480 —t <IP Address>

Such as: arp -s 192.168.0.125 11-40-8c-18-10-11
ping -I 480 -t 192.168.0.125

Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are
output information such as “Reply from 192.168.0.125 ...” from
the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

6.2.1.1 Easy4ip

Click “Enable” to connect the device to network, and then you can connect to the device via mobile

client of Easy4ip after “Online” is displayed on the interface (connection mode: add device serial number
or scan QR code). See Figure 6-30.
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IP Camera

Camera TCP/IP Easydip

2 stonnedion Status offline
> PPPOE

SN 1L0092EPAAD0270
> DDNS

QR Code

> IP Filter
> SMTP(Email)

> UPnP

FRllE | Default I | Refresh I l Save

> Bonjour

> Multicast

> 802.1x
> Qos
> HTTPs
Event
Storage
System

Information

Figure 6-30

6.2.2 Connection

6.2.2.1 Connection
The connection interface is shown as in Figure 6-31.

IP Camera

Camera Connection

Network
> TCPIP Max Connection 10 (1~20)
TCP Port 37777 (1025~65534)
' > PPPoE ) UDP Port 37778 (1025~65534)
> DDNS HTTP Port 80
> IP Filter RTSP Port 564
> SMTP(Email) HTTPs Port 443
> UPnP
> SNMP Defautt || Refresh || sawe
> Bonjour
> Multicast

> 802.1x
> QoS

> HTTPs
Event

Storage

System

Information

Figure 6-31

Please refer to the following sheet for detailed information.
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Parameter | Function

Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. Default connection amount is 10.

TCP port Port range is 1025~65534. The default value is 37777. You can input the
actual port number if necessary.

UDP port | Port range is 1025~65534. The default value is 37778. You can input the
actual port number if necessary.

HTTP port | Port range is 1025~65524. The default value is 80. You can input the
actual port number if necessary.

RTSP port | ® The default value is 554. Please leave blank if use default. User uses
QuickTime or VLC can play the following formats. BlackBerry can play
too.

® Real-time monitoring URL format, please require real-time RTSP
media server, require channel no., bit stream type in URL. You may
need username and password.

® User uses BlackBerry need to set encode mode to H.264B, resolution
to CIF and turn off audio.

URL format is:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
Username/password/IP and port.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value.

Follow standard RTP protocol and when encode mode is MJPEG, the max
resolution only supports 2040*2040.

HTTPs HTTPs communication port, range is 1025~65534, default is 443.
Port

Note:

® (0~1024, 37780~37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 are all special ports.
User cannot modify them.

® Avoid using default port value of other ports.

6.2.2.2 ONVIF

ONVIF (Open Network Video Interface Forum) , this standard describes network video mode,
interface, data type and data interaction mode. ONVIF Standard’s aim is to achieve a network video
frame agreement and makes the network video products (including video front-end, video equipment,
etc.) from different manufacturers completely compatible.

ONVIF function is on by default.
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IP Camera

Camera Connection ONVIF

> TCPIP Authentication @ ON (©) OFF

Default ‘ | Refresh | l Save

> PPPOE

> DDNS
> IP Filter
> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs
Event
Storage
System

Information

Figure 6-32

6.2.3 PPPoE

The PPPOE interface is shown as in Figure 6-33.

Enter the PPPOE username and password which are provided by ISP (Internet Service Provider), and
click “Enable”. The network camera will automatically establish network connection in the mode of
PPPoE after it is enabled, after it is successful, the IP of the “IP Address” will be automatically modified
into the dynamic IP address of the acquired WAN.

Note:

After PPPOE dial-up is successful, it needs to log in the device via the IP which is set before dial-up; in
the PPPOE setup interface, it will display the registered IP address, and then it can visit the IP address
via client.

Please disable UPnP when clicking PPPoE enable, which is to avoid causing influence to PPPoE dial-
up.

IP Camera

Camera PPPoE
Network [ Enable

> TCPIP
Usemame
> Connection

Password

> DDNS
> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

Event

Storage

System

Information
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Figure 6-33
6.2.4 DDNS
The DDNS interface is shown as in Figure 6-34.
The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changed. When the device connects to WLAN, you
should disable UPnP.

IP Camera

Camera DDNS

™ Server Type QUICK DDNS =

Server Address www._quickddns.com

> TCPAP
> Connection

Mode & Auto © manual
> PPPOE

m Domain Name 9002A91CCOCE quickddns com

> IP Filter Username (Optional)Please input the mailbox

> SWTP(Email) peait || Rewesn ][ saw
> UPnP
> SNMP

> Bonjour
> Multicast
> WIFI

> 802.1x
> Qos
Event
Storage

System

Information

Figure 6-34

Please refer to the following sheet for detailed information.

Parameter Function

Server Type Click it to select DDNS protocol type, which includes: CN99
DDNS, NO-IP DDNS, Dyndns DDNS, Quick DDNS, the default is
Quick DDNS.

Server Address | DDNS server IP address

CN99 DDNS

Server address: www.3322.0rg
NO-IP DDNS

Server address: dynupdate.no-ip.com
Dyndns DDNS

Server address: members.dyndns.org
Quick DDNS

Server address: www.quickddns.com

Mode Default is auto, it can select manual
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http://www.quickddns.com/

Parameter Function

Domain Name | Both auto and manual are “MAC addresss.quickddns.com” by
default, it is able to set prefix manually.

Username The user name you input to log in the server, optional.

The CN99 DDNS interface is shown as in Figure 6-35.

IP camera

Camera DDNS

Network

> TCP/IP

> Connection

> PPPoE
oo

> IP Filter

> SMTP(Email) Update Period 10 Minute (1~500)

[C] Server Type CN99 DDNS
Server Address
Domain Name none
Usemame none

Password sese

» UPnP

Defauit H Refresh H Save
> SNMP

> Bonjour

> Muliicast
> 802.1x
> QoS
Event

Storage

System

Information

Figure 6-35

Parameter Function

Server Type You can select CN99 DDNS protocol

Server Address | Under CN99 DDNS, the default server address is “www. 3322. org”.

Domain Name Self-defined domain name

Username The user name you input to log in the server.

Password The password you input to log in the server

. The refresh period of the connection between the device IP and the server, default
Refresh Period | . .
is 10 minutes.

6.2.5 IP filter
The IP filter interface is shown as in Figure 6-36.

You can enable IP filter function so that some specified IP/MAC user can access the network camera.
You can add IP address or IP segment.
If you do not check the box here, it means there is on access limit.
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Here you can add IP address and MAC address. You must add these addresses before enabling the

trusted sites.

Please note: You must set MAC address in the same network segment.

IP camera

Camera

> TCPiIP

> Connection
> PPPoE
> DDNS

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Muliicast

> 802.1x

> QoS

Event

Storage

System

Information

IP Filter

Trusted Sites

Trusted Sites

IP address IMAC address

Modify

Delete

6.2.6 SMTP (e-mail)
The SMTP interface is shown as in Figure 6-37.

IP camera

Camera

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter
SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

Event

Storage

System

Information

SMTP(Email)

SMTP Server
Port

[ Anonymity
Usemame
Password

Sender

Authentication
Title

Mail Receiver

Interval

[7] Health Mail

Figure 6-36

none

25
anonymity
seee
none
None [+]
IPC Message Attachment
+
0 Second (0~3600)
Update Period Second (1~3600)
| oefamn || Refesn || sawe

Figure 6-37

Please refer to the following sheet for detailed information.
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Parameter

Function

SMTP Server

Input server address and then enable this function.

Port Default value is 25. You can modify it if necessary.

Anonymity For the server which supports the anonymity email function, it
won'’t display the information of the sender.

User Name The user name of the sender email account.

Password The password of sender email account.

Sender Sender email address.

Authentication You can select SSL, TLS or none.

(Encryption

mode)

Title (Subject)

Input email subject here.

System can send out the email of the snapshot picture once

Attachment
you check the box here.

Mail receiver Input receiver email address here. Max three addresses.

Interval The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.
Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Health mail Please check the box here to enable this function.

enable

Email test The system will automatically sent out a email once to test the
connection is OK or not .Before the email test, please save
the email setup information.

6.2.7 UPNnP

It allows you to establish the mapping relationship between the LAN and the public network.

Here you can also add, modify or remove UPnP item. For UPnP on different routers, you must disable
UPNP function. See Figure 6-38.

In the Windows OS, From Start->Control Panel->Add or remove programs. Click the “Add/Remove
Windows Components” and then select the “Network Services” from the Windows Components Wizard.
Click the Details button and then check the “Internet Gateway Device Discovery and Control client” and
“UPnP User Interface”. Please click OK to begin installation.
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Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the network camera can auto
detect it via the “My Network Places”.

Under manual mode, you can modify external port. Under auto mode, select idle port for auto port
mapping without user modification.

IP Camera

Camera UPnP

[] Enable Mode | Manual |Z| Router State Mapping Failed
> TCPIP

Port Mapping List

> Connection

Internal Port

> PPPoE WebService WebService TCP 30 8080 Mapping Failed V. -
> DDNS PrivService PrivService:-TCP 37777 3rrer Mapping Failed
> IP Filter PrivService PrivSenvice:UDP 37778 3r7re Mapping Failed
> SMTP(Email) RTSPService RTSPService: TCP 554 554 Mapping Failed

> SNMP

> Bonjour

» Multicast

» B02.1x

> QoS

Event

Storage

System

Information

Figure 6-38

6.2.8 SNMP

The SNMP interface is shown as in Figure 6-39 and Figure 6-40.

The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or
establish the SNMP service before you use this function. You need to reboot the device to activate the
new setup.
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IP Camera

Camera SNMP
Network
> TCPIP
> Connection SNMP Port

SNMP Version

> PPPoE Read Community
> DDNS Write Community
> IP Fitter Trap Address

> SMTP(Email)
> UPnP

SNMP

> Bonjour

Trap Port

> Multicast
> 802.1x
> QoS
Event

Storage

System

Information

[ SNMPv1 [C] SNMPv2 [[] SNMP v3

161 (1~65535)
public

private

162

Figure 6-39

Please refer to the following sheet for detailed information.

Parameter

Function

SNMP Version

® Check SNMP v1, device only process vl info.
® Check SNMP v2, device only process v2 info.

® Check SNMP v3, can set username, password and
encryption method. Server calibrate corresponding
username, password and encryption method too access
device and v1/v2 are unavailable.

SNMP port

The listening port of the proxy program of the device. Itis a
UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Community

It is a string, as command between management and proxy, ,
defining a proxy, and a manager’s authentication.

Read community

Read-only access to all SNMP targets, default is public.
Note: Only number, letter, , and — supported.

Write community

Read/write access to all SNMP targets, default is private.
Note: Only number, letter, , and — supported.

Trap address

The destination address of the Trap information from the
proxy program of the device.

SNMP trap is a proxy message sent to admin as important

Trap :
event notice or status change.
Trap Address Address where to send Trap message.
Trap Port Port which send Trap message, default is 162, range

1~65535.
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IP camera

Camera SNMP

Network

SNMP Version

SNMP v1 SNMP v2 SNMP v3

> TCPIP

> Connection SNMP Port 161 (1-65535)
> PPPoE Read Community public
> DDNS Write Community private
> IP Filter Trap Address
> SMTP(Email) Trap Port 15
> UPnP

SNMP Read-only Usemame public
> Bonjour Authentication Type @ MD5 @ SHA
> Multicast Authentication Password
> 802.1x Encryption Type @ CBC-DES
> QoS Encryption Password
Event
Storage Read&write Usemame private
System Authentication Type @ MD5 @) SHA
Information Authentication Password

Encryption Type @ CBC-DES

Encryption Password

Default | | Refresh ‘ ‘ Save

Figure 6-40

Check SNMP v3 version and SNMP port, read community, write community, Trap address, Trap port
are same with SNMP v1 and SNMP v2 versions. Only when SNMP version is SNMP v3, users need to
configure parameter in chart.

Parameter Function

SNMP Version | SNMP v3

Default is public.

Read-only _
Username Note:

Name only can be number, letter and underline.
Read/Write Defa_ult is private.

Note:
Username

Name only can be number, letter and underline.

Authentication | You may select MD5 or SHA, default is MD5.

Authentication Password not less than 8 characters.
Password

Encryption Default is CBC-DES.

Encryption Password not less than 8 characters.
Password
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6.2.9 Bonjour

The Bonjour interface is shown as below. See Figure 6-41.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the network camera device
and then access if you do not know the network camera information such as IP address.

You can view the server name when the network camera is detected by the Bonjour. Please note the
safari browse support this function. Click the “Display All Bookmarks: and open the Bonjour, system can
auto detect the network camera of the Bonjour function in the LAN.

IP cCamera

Camera Bonjour

Network

> TCPNP

» Connection

> PPPoE Defautt

Enable

Server Name YZCAEZD0SWO00019

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP
Bonjour

> Multicast

» 8021x

» QoS

Event

Storage

System

Information

Figure 6-41

6.2.10 Multicast

The multicast interface is shown as in Figure 6-42.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data

packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host

can just send out one data to transit. This function also depends on the relationship of the group

member and group of the outer.

Note:

® Open preview, streaming media protocol, select multicast, and monitor via multicast format.

® Here you can set multicast address and port. You also need to go to Live interface to set the
protocol as Multicast.
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IP camera

Camera

Network

> TCPNP

> Connection

> PPPoE

> DDNS

> IPFilter

> SMTP(Email)

» UPnP

> SNMP

» Bonjour
T S—

> 802.1x

> QoS

Event

Storage

System

Information

Main Stream

Multicast

Sub Stream

Enable Enable Sub Stream 1 [~]
Multicast Address 224 . 1 . 2 . 4 |(2240.0.0~239.255255255) Multicast Address 29 1 . 2 4 | (224.0.0.0~239.255 255 255)
Port 40000 (1025~65534) Port 40002 (1025~65534)

Figure 6-42

Please refer to the following sheet for detailed information.

Parameter

Function

Enable

Select to enable multicast function. Main stream and sub stream cannot be
used at the same time.

Multicast address

Main/sub stream multicast default address is 224.1.2.4 and its range is
224.0.0.0~239.255.255.255.

Port

Multicast port. Main stream is 40000, sub streaml is 40016,sub stream?2 is
40032 and the range is 1025~65534.

6.2.114G

Note: This function is only for series with 4G module.

4G is a mobile communication system which makes wireless communication integrates with Internet

and multimedia communication.

6.2.11.1 Dialing Setting
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IP Camera

Camera

> T

> Connection
> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> Bonjour

> Multicast

> QoS

Event
Storage

System

Information

Dialing Setting

Mobile Settings

Wireless Net Type  Auto E| [v] Enable

APN 3gnet

Authorize Mode No E

Dial-up Number *99#

Usemname

Password

Update Period 30 Second

Time Range

Wireless Network State

IP Address

Wireless Signal WCDMA 0%
FDD-LTE s— 70%

Default | | Refresh | I Save
Figure 6-43
Parameter Function

Wireless Net Type

Auto, WCDMA, FDD-LTE optional, you can select according
to the operator.

Enable

Check to enable 4G module.

APN

It shall be acquired from the operator according to the setup
of operator.

Authentication Mode

Auto, PAP and CHAP, the authentication algorithm is
different according to different operators.

Dial-up Number

The number is different according to different operator, it can
be acquired from operator.

User name

It shall be acquired from the operator.

Password

It shall be acquired from the operator.

Update Period

It is the period beyond the dial-up period which has been
set, it is 30s by default, which means the device can auto
acquire 4G dial-up status, cut off dial-up to save flow.

Time Range It is the time period to set dial-up. It can activate the function
via message to enable/disable dial-up function if it is
beyond the time period.

IP Address It will display the acquired IP after the dial-up is successful

via 4G.
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6.2.11.2 Mobile Setting

IP Camera

Camera Dialing Setting | Mobile Settings

> TCPIP [”] Message Send | Message Activation Phone Activation

> Connection Receiver 2 Sender + Caller t+
> DDNS —
> IP Filter

> SMTP(Email)
> UPnP

> Bonjour

> Multicast

> QoS

Event

Title Event Message

Storage

Syeem Default || Refresh H Save

Information

Figure 6-44
Please refer to the following sheet for detailed information.
Parameter Function
Message Send In the event, after the corresponding message activation is

enabled, it will send message to the phone of receiver when
event happens. It needs to enable the function of message
activation function in the event interface when using the

function.
Message It can send message ON/OFF to the SIM card inside the device by
Activation the mobile phone in the list, which is to enable /disable the dial-up

function and send REBOOT to restart the device.

Phone Activation You can use the mobile phone in the calling list to call the SIM card
inside the device to enable dial-up function.

6.2.12 WIFI

Note:

Some series devices don’t support WIFI and WPS function.
WPS function is supported by the devices with WPS button.

6.2.12.1 WIFI
WIFI info can show the name, status, IP information of the Current Hot Spot. Usually please “Refresh”
WIFI work information after reconnection to ensure the real-time display of the work status, because it
often takes some time to connect WIFI Hot Spot, which depends on the network signal strength.
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IP Camera

Camera WIFI

I” Enable \ Add 8SID || Search 8SID |
1D List

> TCPAP

> Connection Signal Quality
> PPPOE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

WIFIINFO
> 802.1x Current Hot Spot
> QoS IP address
Event Subnetmask

Storage Default Gateway

System

Information

Figure 6-45

WIFI setting method is as follows:

Step 1

™ Enable ¥ Enable

Click , Show as , means enabling WIFI function.

Step 2

Click “ Search SSID”, and shows the wireless network hot spot of the current network camera
environment in the list.

IP Camera

Camera WIFI

o ¥ Enable Add SSID ” Search SSID |
> TCPAP

> Connection
> PPPoE
> DDNS

12345 K-AES

5370test WPAWPA2-PSK-TKIP+AES
> IP Filter
TP-LINK_465EF6 WPA-PSK-TKIP+AES
> SMTP(Email)
AndroidAP WPA2-PSK-AES
> UPnP

TP-LINK_425796 WPAWPA2-PSK-TKIP+AES
> SNMP

NETGEARG4 NONE
> Bonjour

> Multicast TP-LINK_NIJIAN WPAWPA2-PSK-TKIP+AES

T

> 802.1x

Current Hot Spot  unconnected
> QoS IP address

Event Subnetmask

Default Gateway

Storage

System

Information

Figure 6-46



Step 3

Click “Add SSID” when need to add a wireless network manually pop out an interface in the figure
below, and enter network ID in the dialog box.

Add Wireless SSID (X!

SSID

Ok Cancel

Figure 6-47
Step 4 Double click on one can pop out the signal intensity and authentication of the hot spot.

+ Please enter the password if necessary. Please keep the choice of password index
number same as the router when entering password.

« Please click “connect” if it is unnecessary to enter the password.

6.2.12.2 WPS

IP Camera

Camera WIFI
ork

 Enter PIN

> TCPAP

PIN

> Connection

SsiD
> PPPoE

> DDNS
> IP Filter Status disconnected

 Button

> SMTP(Email) Connecting._| [ Refresn

> UPnP

> SNMP

> Bonjour
> Multicast
_WIFL

> 802.1x

> QoS
Event

Storage

System

Figure 6-48
PIN Number and SSID are both acquired from the router, please “refresh” the work information of WIFI
to ensure the real-time display of work state after filling in correctly.

6.2.13 802.1x

802.1x (port based network access control protocol) supports manual selection of authentication
method to control if device connected to LAN can join the LAN. It well supports authentication, charging,
safety and management requirement of network.
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IP Camera

Camera 802.1x
N ork
> TCP/P

[C] Enable

Authentication
> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP{Email)
> UPnP

> SNMP

Usemame

Password

> Bonjour
> Multicast
> QoS
Event
Storage
System

Information

Figure 6-49

Please refer to the following sheet for detailed information.

Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
6.2.14 QoS

The QoS interface is shown as below. See Figure 6-50.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, and
reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority (64 different priority levels) of the packets and select the
bandwidth of the each queue. Level 0 is the lowest, and level 63 is the highest. It can also discard at the
different ratio when the broad bandwidth is jam.
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IP camera

Camera QoS
Network

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

Realtime Monitor 0

Command 0

> Bonjour
> Multicast
> 802.1x
Event
Storage

System

Information

Figure 6-50
Please refer to the following sheet for detailed information.
Parameter Function
Real-time The value ranges from 0 to 63. The router or the switcher can
monitor provide different service for various data packets.
Command The value ranges from 0 to 63. The router or the switcher can
provide different service for various data packets.
Enable Check it to enable QoS.
Wireless QoS
6.2.15 HTTPs

In the HTTPs setting interface, users can make PC log in normally via HTTPs by creating certificate or

uploading signed certificate, which is to guarantee the security of communication data and provide

safeguard for user information and device security with reliable and stable technical means.

Step 1

Create certificate or upload the signed certificate.

® Please refer to the following steps if you select “Create Certificate”.

1. Select “Setup > Network > HTTPs”, and the system will display the interface of HTTPs, which is
shown in Figure 6-51.
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IP Camera

Camera
Netwo

> TCPIP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

Event
Storage

System

Information

2. Click “Create” and it will pop out the dialog box of “HTTPs”, which is shown in Figure 6-52.

[7] Enable HTTPs
Create Certificate
Request Created

Request Created
Install Signed Certificate
Certificate Path
Certificate Key Path
Certificate Installed
Certificate Installed

Attribute

Refresh

| | Save

| | | | Download

Browse...

Browse...

[R—E—

Figure 6-51

Day*Range :1-5000

HTTPs
Country CN *e.g.CN
IP or Domain name | 10.15.15.211| :
Validity Period 365
Province ‘none
Location none
Organization ‘none
Organization Unit none
Email
Creat Cancel

bl

Figure 6-52

3. Fillin corresponding “Country”, “Province” and some other information, click “Create” after filling in.

It will show the prompt of “Create Successfully”, which means the server certificate has been

successfully created.
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Note:
Make sure the “IP or domain name” is the same as that of the device.
4. Click “Install” and it will install the certificate on the device end, which is shown in Figure 6-53.

IP Camera

Camera

> TCPIP [C] Enable HTTPs

> Connection Create Certificate
> DDNS Request Created
> IP Filter
Request Created = Delete | | I I Download

> SMTP(Email)

Install Signed Certificate
> UPnP
> SNMP Certificate Path
> Bonjour Certificate Key Path | |
> Multicast Certificate Installed
i Certificate Installed = - -
2908 Attribute Issue to: HAP=10.15.15.211; C=CN; ST=none;

M

Event

L=none; O=none; OU=none; EM=;
Issuer: HAP=test, C=CN; ST=test, L=test, O=test,  ~

Storage Refresh | | Save
System

Information

Figure 6-53
5. Click “Download”. It will pop out the dialog box of “Save as”, save the file into the computer.
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R
G@ ! | Search Libraries e
Organize ¥ &=~ o
Deskt m i i
B Desktop Libraries
j Downloads _=_} Open a library to see your files and arrange them by folder,...
‘| Recent Places
Documents
| 4 4 Libraries | Esheay
I |¢| Documents
3 J’ Music J! Msic
I» =] Pictures < Library
> B Videos s
’mL Pictures
i\/ Library

48 Computer

b &y Local Disk (C:) Videos
> ¢ DISKL_VOL2 (D) M Library

I g DISK1_VOL3 (E:) Y
File name: RootCert.cer v
Save as type: [(*,cg[) v]
(4 Hide Folders | sawve || conce |

Figure 6-54
6. Double click the downloaded icon of “RootCert.cer”. The system will display the information
interface of “Certificate”, which is shown in Figure 6-55.
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Certificate u

General IDetaiis I Certification Path

@a Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: test

Issued by: test

valid from 2016/ 7/ 8 to 2020/ 7/ 7

|Insta|lCertificate...J Issuer Statement |

Learn more about terti

[ o< ]

Figure 6-55
7. Click “Install Certificate” and it will pop out the interface of “Certificate Import Wizard”, which is
shown in Figure 6-56.
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Certificate Import Wizard

S

Welcome to the Certificate Import
Wizard

This wizard helps you copy certificates, certificate trust
lists, and certificate revocation lists from your disk to a
certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

< Back [ Next > ] [ Cancel ]

Figure 6-56

8. Click “Next”. Select “Trusted Root Certification Authorities”, which is shown in Figure 6-57.

83



contese o v
e

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
@) Place all certificates in the following store

Certificate store:
Trusted Root Certification Authorities Browse..,

Learn more about certificate stores

i s

Figure 6-57
9. Click “Next”. The system will display the interface of “Completing the Certificate Import Wizard”,
which is shown in Figure 6-58.
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Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

You have specified the following settings:

Cerfificate Store Selected by User RIS = LGl 48 g1)ile:
Content Certificate
< AN »

<Back || Finsh | | cancel

Figure 6-58

10. Click “Finish”, and it will pop out the dialog box of “Security Warning”, which is shown in Figure 6-59.
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Secvuﬁty Warning

You are about to install a certificate from a certification authority (CA)
J.\ claiming to represent:

test

Windows cannot validate that the certificate is actually from "test". You
should confirm its origin by contacting "test". The following number
will assist you in this process:

Thumbprint (shal): 6D811FD2 E82313A8 663514ED 2CA36EGB 7D425FA6

Warning:

If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed
thumbprint is a security risk. If you click "Yes" you acknowledge this
risk.

Do you want te install this certificate?

Yes No

Figure 6-59

11. Click “Yes”. It will pop out the dialog box of “Import Successful”, click “Ok” to complete downloading

certificate, which is shown in Figure 6-60.

B 3 N
Certificate Import Wizard @

| The import was successful.

Figure 6-60
® Please refer to the following steps if you select “Install Signed Certificate”.

1. Select “Setup > Network > HTTPs”. The system will display the interface of HTTPs, which is shown

in Figure 6-61.
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IP camera

Camera

> TCPIP [C] Enable HTTPs

> Connection Create Certificate
> DDNS Request Created
> IP Filter
Request Created I | I l Download

> SMTP(Email)

Install Signed Certificate
> UPnP
> SNMP Certificate Path Browse...
S {Ponioir Certificate Key Path Browse.. ][ Upoas |
> Multicast Certificate Installed
ORIz Cerificate Installed l:’

2a00% Attribute

Event

Storage

Refresh | | Save

System

Information

Figure 6-61
2. Select signed certificate and certificate key path respectively via “Browse”, click “Upload”.
3. Install root certificate, please refer to step 6~11 for more detalils.
4. Check “Enable HTTPs”, click “Save”. The system will display the dialog box of “Need to reboot the
device”, and then the config is valid.

Reboot

ﬂ The configuration takes effect, the device is restarting now, please don't leave this page or close the browser...

Figure 6-62
5. Use HTTPs
Use HTTPs to log in.
Enter https://xx.xx.xx.xx in the browser, and it will pop out normal login interface; the browser will prompt
certificate error if the certificate is not installed, which is shown in Figure 6-63.
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https://xx.xx.xx.xx/

@ cate Error: Navigation Blocke

et

File Edit View Favorites Tools Help

Y Favorites | 5 [B B v ) MOTSAE v

(& Certificate Error: Navigation Blocked , ‘

[@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server,

We recommend that you close this webpage and do not continue to this website.
'@ Click here to close this webpage.

'?Si' Continue to this website (not recommended).

® More information

Figure 6-63
Note:
“xx.xx.xx.xx” is corresponding to your |IP or domain name.

6.3 Event

6.3.1 Video detection
6.3.1.1 Motion Detection
Step 1

Select “Setup > Event > Video Detection > Motion Detection’ and the system will display the interface of

“Motion Detection” which is shown in Figure 6-64.
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IP Camera

Camera
Network

Scene Changing

Eve [C] Enable
| Video Detection
— - ‘Working Period
> Audio Detection
Anti-Dither 5 Second (0~100)
> Smart Plan
Area -Sem
> Ivs :
> Face Detection V] Record
> People Counting Record Delay 10 Second (10~300)
> HeatMap [ Relay-out
> Alarm Alarm Delay 10 Second (10~300)
> Abnormality =
_] Send Email
Storage =5
7] Snapshot
System
Information Default | | Refresh | | Save

Step 2

Figure 6-64

Select “Enable” to enable motion detection function.

Step 3

Set motion detection area.

1. Click “Setup” and the system will pop out the interface of “Setting Area”, which is shown in Figure 5-

65
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-
Region = =

Name l Region1 ‘
sensitivity (=) ————{}——(3) 60
Threshold (=) {}————(@) 5

Figure 6-65

2. Set area name, itis to set valid area of motion detection according to the actual situation, and it can
set the value of sensitivity and threshold respectively.
The bigger the sensitivity is, the easier it is to generate motion detection, the smaller the threshold is,
the easier it is to generate motion detection; the entire video image is the valid area of motion
detection by default.

Note:

® Different colors represent different areas; each area can set different detection area.

® The red line in the Oscillogram means triggering motion detection; green line means not triggering
motion detection.

3. Click “Save” to complete area setting.

Step 4

It is to set other parameters of motion detection, please refer to the following sheet for more details.
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0s to 100s.

Area

1. Click “Setup” and the system will pop out the interface of “Set Area”.

2. Setthe area name, it is to set the valid area of motion detection
according to the actual situation, and it can set its sensitivity and
threshold respectively. The higher the sensitivity is, the easier it is to
trigger motion detect, the smaller the area threshold is, the easier it is
to generate motion detect, the whole video image is the valid area of
the motion detect by default.

Note:

Different colors represent different areas; each area can set different

detection areas.

The red line in the Oscillogram means triggering motion detect, the green

line means not triggering motion detect.

3. Click “Save” to complete area setup.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm audio file when alarm occurs. Use

can set the recorded or uploaded audio file in “camera setting > audio >

alarm audio”.
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Parameter Function

Flash linkage Check it and the flash will be on when alarm occurs, and the flash will
be off until the end of alarm after corresponding delay.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior
snhapshot file. You shall set snapshot period in Storage>Schedule.

Step 5

Click “Save” to complete the setting of motion detection.

6.3.1.2 Video Tampering

Step 1

Select “Setup > Event > Video Detection > Video Tampering” and the system will display the interface of
“Video Tampering” which is shown in Figure 6-66.

IP camera

Camera
Network
Event

> Audio Detection
> Smart Plan

> Vs

> Face Detection
> People Counting
> HeatMap

> Alarm

> Abnormality

Motion Detection JVideo Tampering]| Scene Changing

[C] Enable Video Tampering
Working Period

V| Record
Record Delay 10
V] Relay-out
Alarm Delay
["] send Email

[] Snapshot

[C] Enable Defocus Detection

Second (10~300)

10 Second (10~300)

Storage

Default | ‘

Refresh | I Save

System

Information

Figure 6-66
Step 2
Set the parameter of video tampering; please refer to the following sheet for more details.
Parameter Function
Enable video You need to check the box to enable video mask detection alarm.
tampering

Enable defocus
detection

You need to check the box to enable defocus detection alarm.
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